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Introduction
Thank you for purchasing the JLCooper Media Control Station3.
This MCS3 is an USB device, designed for use with Macintosh
computers.

The MCS3 allows you to create a personalized control station
for virtually any Macintosh application. You will find that the
MCS3’s smooth, optically encoded jog wheel and transport
keys make creative multi-media production and editing easier
than ever.

The MCS3 wheel can play back movies, jog through sound
files, scroll through event lists, and more. And the MCS3 keys
can send command-key equivalents and mouse clicks. In
addition, the MCS3 software will alow long and complex
sequences of commands with just a single keypress, a literal
“macro-command” set capability.

This allows you to use your MCS3 to bring the most frequently
used menu items and commands speedily within reach,
providing more comfortable and creative control of your
favorite applications.

The MCS3 allows you to create an unlimited number of “Keysets”.
You can have a different “Keyset” for each Macintosh application.

The MCS3 detects which application is active, and the behavior
of the MCS3 changes accordingly as you change applications.

The included MCS3 application software and extensions
are required for the MCS3 hardware to operate.

Please take a moment to send in your product registration card,
so we can notify you in the future about any new products or
updates as they become available.
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Connecting the MCS3
First locate an available USB hub port on your Macintosh.
On your Macintosh, the port is identified by the USB icon:

Then plug in the MCS3's captive USB cable.

USB allows you to "hot plug" peripheral devices like the MCS3.
That means you do not have to shut down the Macintosh to
connect the MCS3.
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Installing the Software
If this is your first installation, insert the CD-Rom in
the CD-ROM drive on your computer and run it. The installer
program  will install the software automatically. Follow the
instructions given by the program and read the Read Me file for
any news not covered in this manual revision. After restarting
the Macintosh with the MCS3 plugged in, verify by using the
Extensions Manager that all the extensions are running
correctly.

If there is a previous version of the MCS3

software on your computer:

1. Make a screenshot copy or write down the commands of any
keysets you wish to save. (the older keysets are NOT
compatible with the present software revision).

2. Remove the older software program, the keysets folder and
the extensions (located in the Extensions folder within the
System Folder).

3. Insert the CD-Rom in the CD-ROM drive on your computer
and run it. The installer program  will install the software
automatically. Follow the instructions given by the program
and read the Read Me file for any news not covered in this
manual revision.

4. After restarting the Macintosh with the MCS3 plugged in,
verify by using the Extensions Manager that all the extensions
are running correctly.
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Getting Started
First of all, remember that the MCS3 Extensions are required for
the MCS3 to operate.

The MCS3 will not appear to send any commands into the
Macintosh unless the Extensions have been properly loaded
and are running.

Shuttle and Record LEDs
Normally on power up, the shuttle ring  LEDs will not light
until the shuttle ring is centered. The Record LED will also be
off.

After that, the shuttle ring LEDs will light depending upon the
direction of rotation from center. Both LEDs are on when the
ring is centered. The Record LED will light when the record
button is pressed. (this is a handy way to make sure that the
MCS3 is connected correctly and that the Macintosh recognizes
it.

If the MCS3 still fails to respond correctly with the LEDs or does
not respond within the MCS3 software application, then please
refer to the Troubleshooting section on page 30.

Launching the MCS3 Software Application
The application is launched by double-clicking on the MCS3

icon.

If the extensions are not loaded or the MCS3 is not connected,
the MCS3 application will run but no changes will be saved.
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What Does the MCS3 Do?
When you press a key or turn the wheel, the MCS3 behaves
like a Macintosh keyboard or mouse, sending a command
character.  The comfortable tactile-responsive controls provide
a logical and intuitive control interface for your application.

The main strength of the MCS3 is the support of the software
application provided with the MCS3 which creates keysets for
the particular software applications. Not only are simple direct
key presses supported, but the key presses can be supported
with key modifiers (such as control, shift, option, etc..).  The
keypress can also correspond to a mouse clicked location
onscreen, for applications that have no keyboard equivalent
available. In addition, each MCS3  command (except for the jog
ring and shuttle wheel) can be set for a sequence of commands
given (up to 12). As an example, the  can be set so that the
record button would perform the following sequence:

press command R (set recording counter to 00:00:00)
delay of 30 ticks (wait 1/2 second)
press control A (arm all recording tracks)
click screen box w/mouse (disable recording interlock)
press open apple R (hit RECORD button)

Some keysets for popular applications have built-in  keystrokes
that can also be used within the sequence per key.



The MCS3 Controls
The MCS3 control surface has 5 basic areas of control. Refer to
the illustration below.

The Jog/Shuttle wheels are located in the center of the unit.
The Jog wheel may be rotated in either direction at any speed.
The Shuttle outer ring has a central detent and may be rotated
about 55 degrees in either direction from center. Above the
Jog/Shuttle wheels are two arrow shaped LEDs. These LEDs
show the status of the Shuttle ring. Both LEDs on indicate that
the Shuttle ring is centered.

The Transport controls are located on the bottom of the MCS3.
The controls from left to right are Rewind, Fast Foward, Stop,
Play and Record. The Record button has an LED above it to
indicate Record status.

The V-stick is a small joystick located to the upper right side of
the MCS3 and is surrounded by 4 arrows on the metal. Each
arrow corresponds to which directions the V-stick is capable of.

The F and W key groups are sets of push buttons grouped in a
logical order. The F buttons are marked F1 to F6 and are
located as the top row of buttons on the MCS3. The W buttons
are marked W1 to W7 and encircle the Jog/Shuttle wheels.

9
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The MCS3 Application
The MCS3 application lets you test the MCS3 and work with the
Keysets. The left side is the graphic representation of the MCS3.
The light grey box on the right is the Control Tabs, which let
you set which actions and keypresses are performed by the
Keyset. The lower right dark grey box is the sequence box,
which allows up to 12 actions (key presses, mouse clicks or
delay periods) per MCS3 control press.

The MCS3 application is used for testing the MCS3 and working
with the Keysets. You do not need to use the  MCS3 application
during your regular work unless you wish to perform the above
functions. The Keysets created will be loaded by the MCS3

extensions and will activate for each target program you are
working with.

Try it Now
Launch the MCS3 application and select "About Media Control
Station".  This will bring up a credit screen.

Use the Transport commands and the Jog Wheel to scroll the
credits screen back and forth.
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MCS3 Application's Menus

File Menu
New Keyset...
Creates a New Keyset, and links it with a particular Target
Application.

In other words, when you are ready to start defining the
function of the MCS3, the first thing you do is select New
Keyset.

You will see a standard dialog. Then select the application that
you wish to control with the MCS3. We refer to that application
as the "target" application, simply to distinguish it from the
MCS3 application.

Then you use the MCS3 application to assign what each control
will send. These assignments are collectively called a Keyset.

Import Keyset...
Imports a previously exported Keyset file. Places the Keyset
into the Keysets menu.

Export Keyset...
Exports a Keyset as an independent file, to allow you to more
easily transfer the file to another computer.

Quit

Exits the MCS3 Application. Once you have defined your

Keysets, the MCS3 application does not need to be running for
the MCS3 hardware to operate.
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Edit Menu
Undo Undoes last operation. This command may also reflect
the previous operation.

Cut Copies the currently selected text the Clipboard.
Clears text.

Copy Copies the currently selected text to the Clipboard.

Paste Pastes the previously copied text.

Clear Clears the selected text.

Select All Selects all of the text within the active window.

Delete Current Keyset Deletes currently selected Keyset. Will
not delete the Default Keyset.

Keysets Menu
This menu contains a list of all the Keysets that you have
created or imported.

It will always at least contain the Default Keyset.

Use this menu to select a Keyset to display the control
assignments and edit them.

Display Keyset
Opens window which displays all the names and control
assignments used in the Keyset Please see “Display Keyset” on
page 15 for more information.
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Actions Menu
Use Partial Window Name This command is reserved for
future versions.

Windows Menu
Media Control Station 3 Opens the MCS3 program application
window. You can keep both windows onscreen and switch
back and forth with these two menu items.

Display Keyset Opens window which displays all the names
and control assignments used n the Keyset Please see “Display
Keyset” on page 15 for more information.

Help Menu

Help Center This will bring up the main Macintosh help menu
which has help features for a variety of programs. The MCS3 V2
help can also be accessed from this menu. .

Show Balloons This command will turn on the help balloons
for ease of use in the menus.

MCS3 V2 Help this will bring up the MCS3 V2 help menu. It is a
condensed version of the information found within this
manual.
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Keysets
What is a Keyset?

The keyset is the currently loaded set of definitions of all the
controls on the  MCS3. By control definition, it is meant of the
way that each control is set to act on the computer. All the
macro sequences, keyboard equivalents, mouse click locations
and keyboard modifiers, those all fall under control definitions.

The screen above shows a typical keyset definition. The keyset
also includes 3 banks, so each keyset can have 3 seperate sets
of commands running, depending on which bank is in use at
the time.

Several keysets have been included with the software package.
New keysets can be created, exported to give to others, or
keysets may be imported from other computers or online.
(older software revision keysets cannot be imported).
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Display Keyset
When Display Keyset is selected, a second window opens.

This window displays the current assignments of each control
in the Keyset.

Notice how each control has 4 lines. The top line is the name
of the control while the lower 3 lines are the Banks 1,2 and 3
assignments. Running the mouse pointer over the name will
show the complete macro sequence, if any.

Click the close box when finished with this window.
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About The Default Keyset
The first time you use the MCS3, the so-called "Default Keyset"
is automatically selected.

The Default Keyset is ready to use and has some functionality
with QuickTime-related applications.

The wheel sends left and right arrow keys, to playback
QuickTime™ movies one frame at a time.

Play and Stop keys send a space and return, respectively.
These keys play and stop QuickTime movies.

F1 through F6 send function keys F1 through F6.
The V-Stick sends up, down, left and right arrow keys.

The W keys have no assignment. They will not send any
keyboard commands or mouse clicks unless you edit the
Default Keyset.

Any time you open an application, if you haven’t yet created a
Keyset for that specific application, the Default Keyset will be
automatically selected.
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Keyset Selection
One Keyset can be created for each application.

On the File menu,  select “Create New Keyset”. The MCS3  will
show a dialog box asking you to select which application the
keyset is for. Select the application to create the keyset for
(program aliases won’t be shown). Double click the
application name, and the new blank keyset will be created
and show in the upper left keyset pop-up bar.

If it is desired to bring in an external keyset, select “Import
Keyset” from the File menu. Double click on the keyset to
import.

Please note that on the right side of the same bar, the “Current
Bank” red light selection is set to 1. When you load in the
Keyset, the bank will begin at 1. You can select and edit the
other banks. The bank that is selected when you close the
application is the bank that will be used for that particular
keyset.

Under the Windows file menu,  select the Keyset Display
choice (or command 2). This will show a graphic display of the
keyset. Each control will have 4 lines, the top being the name
assigned, and the 3 lines down being the commands set for
each bank. Pointing on the command will show the whole
macro sequence, if the command is a macro set. (editing the
commands will be covered later in this manual, in “editing the
default keyset” on page 20.
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Creating a New Keyset
Remember that a Keyset is the collection of commands that the
MCS3 can send. Each application can have its own Keyset.
The MCS3 senses which application is active, so it knows
which Keyset applies to each application.

When you are ready to start programming the MCS3, you begin
by selecting New Keyset from the File menu. This "links" the
operation of the MCS3 with the application you want to
control.

Select New Keyset from the File menu.

This opens a Select dialog. Select the application that you wish
use with the new Keyset.

(Please note that the other icons are Help on the bottom left,
and the upper 3 are Shortcuts, Favorites and Recent
Applications, respectively, which are standard Finder icons).

The currently active Keyset name is displayed in the upper left
part of the MCS3 window.
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Saving and Deleting Keysets
The MCS3 Keysets are automatically saved within the MCS3

application’s Preference file. You never have do a "Save" when
using the MCS3 application.

To delete a Keyset, select the Keyset from the Keyset menu.
Pull down the Edit menu and select Delete Current Keyset from
this menu. You cannot delete the Default Keyset.

Importing and Exporting Keysets
Keysets, though automatically stored invisibly within the
Preferences file, may also be Exported or Imported.

This allows you to easily move Keysets from one location to
another, such as another computer. It also allows third-party
Keysets to be developed and added at any time.

To Import a Keyset, select Import Keyset from the File menu.
A standard Open dialogue lets you select the Keyset.
Once imported, the Keyset will appear in the Keysets menu.
It will also automatically be saved in the Preferences file.

To Export a Keyset, select Export Keyset from the File menu.
A standard save dialogue will appear, to allow you to choose
where to put the exported Keyset. The Keyset retains the name
of the application that it is linked to.

Using Supplied Keysets
Some Keysets for selected applications are included on the
MCS3 disk. Refer to any Read Me files on the disk for a
description of the functions provided by these Keysets.

To use any of these Keysets, select Import from the File menu.
Then select the Keyset within the Import dialogue.

The Keyset will then be automatically saved in the
Preferences file, and will appear in the Keysets menu.
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Editing the Default Keyset
You can edit (that is, change) the Default Keyset at any time,
using the MCS3 application.

WARNING!
Before editing the default Keyset, it is HIGHLY recommended
to Export the keyset. This way, you can re-import the original
Default Keyset if desired.

Example of Changing the Wheel Action
Presently, the wheel sends left and right arrow keys at a
medium speed.

Turning the wheel will play a movie in a QuickTime™ related
application, such as Movie Player.

Suppose you are editing a movie, and you want to use the
wheel to easily view the movie frame by frame. You may want
to slow down the response of the wheel, to make it easier to
find a specific frame.

First, rotate the wheel a little in either direction or click on the
left or right picture of the wheel.



The Wheel Slider setting affects the wheel speed for either
direction of rotation. For the purposes of this example, it
doesn't matter whether you select clockwise or counter-
clockwise rotation.

Click on the Wheel Slider and drag it downwards.

Now the next time you switch to a QuickTime™ related
application, the wheel will make the movie play back slower,
allowing finer control.

The Wheel Slider is covered in more detail on page 29, “The
Wheel Slider and example”.

21
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Example of Changing a Key Action
Presently, in the Default Keyset, pressing the Record key does
nothing. Suppose that you want the Record key to send the
equivalent of the Macintosh's Enter key.

Press the MCS3 Record key to select it. Notice that the Selected
Control and the Name box right below it both say record. You
can select the Name box and type in a new name, such as “The
Record Function”.

Now on the 4 tabs below the names, select Keystrokes. Notice
that the fields are all blank. Select the optinal name bar with
the mouse then type a name in the optional name box. This
will be the name of a button press emulated from the
keyboard. Let us call it: “Command R Keypress”. Enter this text.

Now use the mouse to select the Keystroke box. Now type in
the keypress combination you wish to emulate. If you use the
Command R as the optional name suggests, a lowercase “r” will
appear in the Keystroke box, and a check mark will appear in
the box below.

Below and to the right is an Add/Insert box. Click this box with
the mouse. Notice how the gray box to the left of this button
just added the command you created. Now go lower with the
mouse and change the number of ticks. (60 ticks=1 second).
Then click the Insert Delay button. Now click the Add/Insert
button once again.

What is created is now when you press the Record button, it
pressed the command R key, waits the time specified, then
presses it again. You can make and use different keypresses,
for up to 12 actions per key. To clear the selection, select the
area with the mouse to clear in the grey box, then press the
“Clear Selection” box.
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Restoring The Default Keyset

The previously mentioned examples WILL change the Default
Keyset, and have it saved into the Preferences. There are 2
ways to restore the Default Keyset.

a. In the section on Editing the Default Keyset, it was highly
recommended to do an Export Keyset on the default keyset. It
is a simple matter now to go to the File Menu and Import the
Default Keyset. This will bring back to factory spec.

b. If there was no exported version saved, the  MCS3 V2
software must be re-installed. Refer to page 6, “Installing the
software” and follow the procedure for previously installed
versions. If you already had other keysets modified, export
those keysets to a safe place (such as another folder).
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The MCS3 controls are assigned into the key equivalents and
macro sequences by the Control Tabs. The control assignments
will save into the keyset loaded into the  MCS3 program.

The Built In Tab
The Built in Tab will show optional commands for factory
programmed keysets. (the Default Keyset and self made keysets
will show that there are no built-in commands).

The commands from this tab and the 3 others are used within
the Sequence Window.

Example
Launch the MCS3 program. It is not necessary to have the MCS3

connected. Click in the “Built In” tab. Chang the Keyset to
Default. Notice how the message says there are no built in
commands. Now, change the keyset to the Final Cut Pro
Keyset.

Click the Built In tab. Notice how it a hierarchical menu. Click
on the Jog and Shuttle blue triangle to open this menu item.

Notice how there are two menu items, Jog and Shuttle (FCP2).
Now click on any of the MCS3 buttons on the left picture and
note how both the Jog and Shuttle items dim. Now click on the
Shuttle arrows. Note that the Shuttle menu item now dims.

Click on the left and right Shuttle arrows. Note that the
Sequence window has several sequence items on the Ring
Clockwise setting while the Ring Counter-Clockwise is blank.
Use this setting.

In the Built In Tab window, double click on the Shuttle menu
item. The Shuttle menu item will appear in the Sequence
window.
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The Keystrokes Tab
The Keystrokes tab will allow a direct Macontosh keyboard
keypress to be defined as the control action.

There is 3 fields within this tab. The Name (optional) allows
you to name the keyboard action. The Keystroke is what
keystroke itself is the action. The box below is the modifier
keys utilizing 4 icons for the standard control keys. The Tab
and Delete keys work standard in which the Tab key selects the
different text fields and the Delete key will clear the selected
field.

      Command           Shift       Option      Control

Example
Launch the MCS3 program. It is not necessary to have the MCS3

connected. Click in the “Keystrokes” tab. Change the Keyset to
Default.

Now click on the Keystrokes tab. Press the Rewind button on
the MCS3 or click on it on the MCS3 screen graphic. Notice that
the selected control and name box above the Control Tabs now
say Rewind.

Click in the Keystroke box’s Name (optional) box and type in a
name. Now click the Keystroke box with the mouse. Now hit
Control-R on the Macintosh keyboard.

In the Keystroke box will appear a lowercase “r” and the
Control checkbox in the Modifier Keys will be checked.

If you define a jog or shuttle control, the keyboard character
assigned will repeat as long as the control is being activated.



The Mouse Tab
The Mouse Tab allows an MCS3 control to be interpreted by the
Macintosh as a mouse function. This is useful as some program
buttons are mouse selectable without keyboard equivalents.

The Mouse tab has 4 fields.
a. Name field: same usage as the keyboard tab for naming the
particular action
b. Mouse Action: This pull down menu will highlight 3 different
types of actions, depending on which MCS3 control is being
used. A button will allow only the mouse button click. The jog
wheel will allow a vertical or horizontal drag or move. The
shuttle ring will allow a vertical or horizontal scroll.
c. Click Location: This pull down menu will give a point of
reference for the captured mouse movement or click point. The
reference can be to a window edge or or an edge, percentaged
to the window’s width (useful for resized windows)

26



Example
Launch the MCS3 program. (it IS necessary to have the MCS3

connected for this example). Click in the “Mouse” tab.  Change
the Keyset to Default.

For a secondary, let use use the built in Stickies program  as an
example.
1. Select an MCS3 control. The Rewind key will be used. In the
MCS3 program window, press the Rewind key. Now select the
Mouse tab.

The Mouse Action will show the Mouse Click. Leave that alone.
On the Click Location, select any of the settings. Since this is a
click, the setting for this tab is not that important.

Now, go back to the target program (stickies) and place the
mouse pointer in the window and area you wish to click it in.
Press the MCS3 rewind key. This will allow the correct capture.

Now type up any text, random letters in the Stickies window.
Position the mouse cursor over any point. Every time you press
the Rewind key on the MCS3, it will act as if you pressed the
mouse key.

Now, let us try a jog wheel capture. Go back to the MCS3

program. Turn the jog wheel a small amount to select within
the mouse tab. In the Mouse Action menu, select Horizontal
Move. On the Click Location, select relative to window top left.

Go back into Stickies and place the cursor within the text once
again. Now move the jog wheel left or right. You will see the text
cursor move with the jog wheel. (if you had selected the vertical
scroll, it would still scroll horizontally in the text window
becuase of the way the text cursor is handled).

27



The Special  Tab
The Special tab will allow certain functions not covered by the
other tabs.

A button press can be assigned as a bank 2 or 3 selector. This
means that any button can switch the control banks, allowing
user control of the banks instead of having the program switch
to the banks. The bank switch control press will be the same
for the first bank as well, forming a toggling bank control. For
example, W2 can be assigned to switch to Bank 2, and W3 for
bank 3. W1 would duplicate the Bank 2 or 3 command,
allowing it to switch back to bank 1.

The Special Modes A-F are not assigned at the present time.
Those are for developer programming, to create special modes
not covered by the rest of the definitions. All controls can be
affected by the special modes.

The JKL Shuttle Mode affects only the shuttle ring. When
selected, the shuttle ring will send out these standard
commands, for those programs which support it.

28
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The Wheel Slider
The Wheel Slider allows you to set a speed setting of the jog
wheel or shuttle ring. The wheel can allow up to 4 speed
settings while each diretion of the shuttle ring will allow up to
12 increments.

Example
Launch the MCS3 program. It is not necessary to have the MCS3

connected. Click in the “Keystrokes” tab. Change the Keyset to
Default.

Select the jog wheel. Go to the Keystrokes tab. Move the Wheel
Slider control down to the very bottom, dragging it with the
mouse pointer (you must click on the blue pointer; it will NOT
follow a click on the slider bar).

Now click on the Add/Insert button below the slider bar. This
will add the first entry into the Sequence box.

Move the Wheel Slider upwards a little more. Clck on the Add/
Insert button once again. Repeat this two more times with
different blue pointer settings.

When you double click on the sequence box entry, you will see
the blue pointer move to where it was selected.
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Technical Information
Specifications
Dimensions: ...................6.5" x 7.0" x 1.25"

Shipping Weight: ...........3.7 lbs

Tr oubleshooting
If for some reason the MCS3 does not give you the expected
results, take a moment to do some investigating.

The most important concept is that the extensions are required
for the MCS3 to operate. Confirm using the Extensions Manager
that both extensions are enabled.

If the unit is not operating at all, or if an error dialog appears,
use Apple System Profiler (2.0 or later) to confirm that the unit
is currently detected by the Macintosh.

As with any peripheral device, certain extensions could
possibly hinder the operation of the unit.  First disable
all suspect extensions or control panels using the
Extensions Manager, and re-start the computer.

If the problem is corrected, then re-introduce the extensions
back into the Extensions Folder one at a time, restarting each
time, until the problem re-appears and the conflicting file is
discovered.
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Care and Service
If properly cared for, your MCS3 should provide years of
trouble-free performance. Avoid dropping the MCS3, or hard
banging on the keys.

Clean with a soft cloth dampened with window cleaner.
Do not allow liquids to get inside the unit.

There are no user-serviceable parts in the MCS3. Please refer to
the really fine print following for detailed warranty and service
information.



JLCooper Electronics Limited Factory Warranty
JLCooper Electronics (“JLCooper”) warrants this product to be free of defects in
materials or workmanship for a period of 12 months from the date of purchase.

This warranty is non-transferable and the benefits apply to the original owner. Proof
of purchase in the form of an itemized sales receipt is required for warranty coverage.

To receive service under this warranty, customers in the United States should
contact the JLCooper factory at 310-322-9990 and talk to a service technician.
If necessary, a Return Authorization number may be issued.

For our customers outside the United States, it is recommended that you first contact
your Dealer or Distributor, since they may offer their own service or support policy.

If local support is not obtainable, please send a FAX to JLCooper’s Service
Department at 310-335-0110, with a detailed description of the service required.

Upon issuance of return authorization, the product should be properly packed and
shipped to Service Department, JLCooper Electronics, 142 Arena St., El Segundo, CA
90245.

Please include the following: copy of the sales receipt, your name and address (no
P.O. Boxes, please), a brief description of the problem, and any other related items
discussed with the service department and considered necessary to evaluate the
product or effect a repair. The return authorization number must be clearly written
on the outside of the package.

JLCooper will, without charge for parts or labor, either repair or replace the
defective part(s). Shipping costs are not covered by this warranty.

JLCooper’s normal repair turn around time at the factory is approximately 15
business days, from receipt of product to shipping. Your actual turn around time
will include return shipping.

Actual turn around time will vary depending upon many factors including the
repeatability of the customer’s reported complaint, the availability of parts required
for repair, the availability of related products needed to evaluate the product if
necessary.

Priority services are available. These should be discussed with the service technician
at the time the return authorization is issued.

This warranty provides only the benefits specified and does not cover defects or
repairs needed as result of acts beyond the control of JLCooper including but not
limited to: abuse, damage by accident/negligence, modification, alteration,
improper use, unauthorized servicing, tampering, or failure to operate in accordance
with the procedures outlined in the owner’s manual; nor for acts of God such as
flooding, lightning, tornadoes, etc.

THE DURATION OF ANY OTHER WARRANTIES, WHETHER IMPLIED OR EXPRESS,
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTY OF
MERCHANTABILITY, IS LIMITED TO THE DURATION OF THE EXPRESS
WARRANTY HEREIN. JLCOOPER  HEREBY EXCLUDES INCIDENTAL AND
CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO: LOSS OF TIME,
INCONVENIENCE, DELAY IN PERFORMANCE OF THIS WARRANTY, THE LOSS OF
USE OF THE PRODUCT OR COMMERCIAL LOSS, AND FOR BREACH OF ANY
EXPRESS OR IMPLIED WARRANTY OF MERCHANTABILITY, APPLICABLE TO THIS
PRODUCT. JLCOOPER SHALL NOT BE LIABLE FOR DAMAGES OR LOSS
RESULTING FROM THE NEGLIGENT OR INTENTIONAL ACTS OF THE SHIPPER
OR HIS CONTRACT AFFILIATES.  THE CUSTOMER SHOULD CONTACT THE
SHIPPER FOR PROPER CLAIMS PROCEDURES IN THE EVENT OF DAMAGE OR
LOSS RESULTING FROM SHIPMENT.


